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Printer Overview

Introduction This chapter is intended to familiarize you with the AccuFlex Series printer.

ATTENTION

Optional subassemblies are described in the AccuFlex™ Options Guide.

In this chapter This chapter is divided into the following sections:

Topic See Page

Power Requirements 2

Option Licenses 3

The Microsoft Windows 2000™ Operating System 5

Units of Measurement 9

Starting The AccuFlex Printer 10

The AccuFlex Main Window 12

Process Operation Buttons 18

User Access 19

Working With Product Files 22

Defining the Beacon Signals 24

Initializing 26

Fitting Squeegees 27

Configuration Options 29

Utilities 32

Using the Help System 40
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Power Requirements

            
Power Requirements

Introduction The printer is factory configured to one of these voltages as stated on the rear panel 
label.

Electrical

Pneumatic A 90 psi/620 kpa clean air supply of 1 cfm (24 liters/minute) is required.

The optional vacuum system requires 25 cfm (600 liters/minute).

The pneumatic connection to the printer is via a bulkhead connector that 
accommodates a 1/2 inch (12mm) outside diameter nylon tube.

Air is internally filtered and regulated.

Configuration Current Load (Amperes)

110 - 115 V power 5

220 - 230 V power 3

220 - 230 V power with Vacuum Stencil Wiper 8
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Option Licenses

                   
Option Licenses

Introduction A license is required to run the following AccuFlex options: 

A timed license expires on a stated date.

An unlimited license is valid indefinitely. 

Each license is unique, generated from the serial number and unique system data, 
and it can only be used on the printer to which it was issued. 

If a 90-day license has expired, a message appears and the license is deleted. Contact 
Speedline for a new license string. 

It is a good idea to write down license numbers for future reference.

Installing Licenses To install software licenses:

Step Action

1 Click Licenses on the Configure menu.

2 If you do not yet have a new license string to enter:

Write down the unique Machine ID displayed on the dialog.

Contact Speedline, provide the Machine ID, printer Serial number, and 
details of the access desired.

3 If you have a license string to install, click in the New license box.

4 Type the license string. Enter letters and numbers only. AccuFlex will 
enter the spacing characters in the correct locations.

5 Click Install.

UP5041
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Option Licenses

                 
Deleting Licenses To delete a software license:

Step Action

1 Click (in the Installed licenses box) on the license you want to delete so 
that it is highlighted.

2 Click Delete.

3 Click Yes to confirm the deletion.

4 To close the dialog, click Close.
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The Microsoft Windows 2000™ Operating System

           
The Microsoft Windows 2000™ Operating System

Microsoft Windows 2000 is an easy-to-use system for controlling computer software. 
Each task that you perform appears inside its own rectangle, or window. You can 
open several windows at the same time, to keep track of multiple tasks. 

You control the printer by using buttons, check boxes, scroll bars, or by typing specific 
information into areas called fields. 

If you are familiar with Microsoft Windows and are comfortable entering information 
with a keyboard and trackball using dialog boxes and other system conventions, skip 
this section.

Using the Trackball 
Controller

Use the trackball to move the pointer around the screen. Roll the ball in the direction 
you want the pointer to move.

In some cases, because we are using camera images in windows, this motion may 
be reversed. In such cases, rolling the ball in one direction will cause the pointer to 
move in the opposite direction.

The trackball has three buttons. The left button is most commonly used. Use it to 
select all types of menu items, buttons, and check boxes.

The right button, in some cases, provides faster access to menu items. Right clicking 
certain items will cause sub menus to appear next to that item. This allows you to 
select the item and access its menu options in the same operation. It eliminates the 
separate step of selecting menu items or toolbar icons. This can be a handy time-
saving step. 

The center button and its wheel are not used. 

UP5450
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The Microsoft Windows 2000™ Operating System

           
Trackball Operations Common trackball operations are:

Operation Description

Clicking Position the pointer on a button or check box, or in a field, and 
press the left button on the trackball.
The object will change state: 
• a button will show a dot in its center, 
• a check box will show and x, 
• a command button will appear to be pushed in, 
• or an item in a list will appear on a white background.
Clicking a selected object reverses its state.
If you click in a data field, the pointer will change to a vertical bar, 
called a cursor. The cursor allows you to type information in that 
location.

Double 
clicking

Double clicking selects an object and executes an action associated 
with it. You could single click an item and press the OK button, or 
you could double click the object and accomplish the same thing.

Dragging You may need to move an object or window on the screen so that 
you can see another object or window. To move an object by 
dragging:
1. Position the pointer on the object and press and hold the left 

trackball button.
2. While holding the left button, move the trackball to reposition 

the object.
3. Release the left button on the trackball.

Resizing a 
window

If you need to change the size of a window to see or gain access to 
something beneath that window:
1. Position the pointer at the lower right hand corner of the win-

dow. The pointer will change to a diagonal double arrow. 
2. Press and hold the left button on the trackball.
3. Drag the corner diagonally until the window is the desired size. 
4. Release the left button on the trackball.
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The Microsoft Windows 2000™ Operating System

       
Minimizing, 
maximizing or 
Closing a 
window using 
the window 
status buttons

You will find three icons in the upper right corner of every window. 
These are the window status buttons.
At the left is the minimizing button. If you click this button, the 
window disappears, but an icon, with all or part of the window’s 
name, appears at the bottom of the screen. If you click this icon, 
the window reappears. 
The middle icon is the maximizing button. Clicking this button 
makes a window fill the complete screen, or, if it already fills the 
screen, the button reduces its size. The window may then be 
manually resized. 
Windows are often closed by clicking an OK or Cancel button 
within that window. Another way is to click the X button, or Close 
box, which is the icon to the right at the upper right corner of the 
window.

Scrolling When the quantity of information displayed exceeds the size of a 
window, a scroll bar appears to the right of that window. A scroll 
bar may also often appear at the bottom of a window. The right 
scroll bar allows you to move the contents of the window up or 
down, and the bottom scroll bar allows your to move the contents 
left or right.

Move through the window an item at a time by clicking the scroll 
arrows, hold the arrows to scroll quickly. Click near the scroll box to 
move in large increments, or drag the scroll box to a desired area of 
the window.

Operation Description

UP5002

Close Box

UP5003

Scroll Down

Scroll BoxShaded Bar Moves Up or Down
Several Items at Once

Scroll Up
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The Microsoft Windows 2000™ Operating System

                   
Trackball Motion 
Control Modes

The following describes the motion control modes.

Selecting Menu 
Options

Position the pointer on an item in the menu bar at the top of the screen and click the 
left button on the trackball. Click the desired option in the drop-down menu that 
appears. This may take you to a dialog box, or cause more menu options to appear. 
Click on an option in the new menu in the same way.

Entering Data in 
Dialogs

You will be required to enter data in various fields in dialog boxes. Click in the field. 
Replace existing data in the field by dragging to highlight the information, double 
clicking, or backspace to delete the information. Then type the new data.

Numeric Keypad To enter numeric data, the on-screen numeric keypad may be useful. Double clicking 
in a field that requires numeric data brings up the numeric keypad.

Use the backspace or delete button to correct mistakes.

Click OK when finished.

Mode How to Activate When to Use

Fine Adjust Roll the trackball. Use fine adjust to move axes/
components slowly, in small 
increments, over short distances. 
Fine adjust provides precise 
motion control.

Velocity Hold down the SELECT button and 
roll the trackball. 
Note: The further you roll the 
trackball the faster the axis/
component travels.

Use the velocity mode to move 
axes/components quickly over 
long distances. Once you move 
the axis/component to the 
desired area, use the fine adjust 
mode to position it precisely.

UP5004
Delete Button
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Units of Measurement

                         
Units of Measurement

You may enter information with imperial (inches) or metric units of measurement. 

Changing Units of 
Measure

To change units of measure in the Windows operating system:

Step Action

1 If the Accuflex software is running (if you have logged on), close down 
the software by logging off. This brings you back to the Windows 
operating system.

2 Click on the Windows Start menu in the lower left of the screen.

3 Click Settings.

4 Click Control Panel.

5 Double click on the Regional Settings icon. The Regional Settings 
Properties dialog appears.

6 Click on the Number tab.

7 Select U.S., (imperial) or Metric in the Measurement system option list 
box. 

8 Click Apply.

9 Click OK. Click the Close box on the Control panel window.

10 Restart the computer. The change will be in effect.

UP5052

Select U.S.
(Imperial)
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Starting The AccuFlex Printer

                 
Starting The AccuFlex Printer

Introduction This section explains how to turn on, log on, log off, and shut down the printer.

Startup Procedure To turn on and log on to the printer:

Step Action

1 Turn on the rotary isolator switch, located on the front of the printer.

ATTENTION

The Accuflex has two large EMERGENCY STOP buttons 
located on the front of the cabinet on either side. Push 
either of these buttons to remove system power and 
immediately stop all machine movement. To reset the 
button, turn it counter-clockwise. 

2 Turn the computer monitor on, if it is not already on. The Accuflex 
displays the Windows Log On Screen.
Press OK. No password is necessary. 

3 If the printer is connected to a network, enter your password and press 
OK. The User log on dialog appears.

UP5449

UP5001
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Starting The AccuFlex Printer

      
Begin Log On Dialog 
Problems

If the begin log on dialog does not appear, check that:

1. The electricity mains are properly connected.
2. The computer and monitor are turned on with their own switches.
3. The monitor brightness and contrast controls are set correctly.

Shutdown 
Procedure

To log off and turn off the printer:

4 Enter your name and password. The password will appear as asterisks. 
Check Remember log on name, and click OK. 
The next time you log on, you will enter only your password. 

5 A message appears telling you to be sure the EMERGENCY STOP 
buttons are released and to press the SYSTEM POWER button.
Please press the green System Power switch. The red E-stop must be 
released.

6 Press the SYSTEM POWER button. It will illuminate. Click OK.

7 The AccuFlex initializes and the AccuFlex main window appears. 

Step Action

Step Action

1 Select Exit from the File menu. You will be prompted to save any 
changes you have made.
If an operation is in progress, you may stop it and close down or ignore 
and continue.

2 Click the Windows Start menu. Select Shut Down...

3 Select Shut down the computer. Click Yes.

ATTENTION

Always shut down the AccuFlex computer by using the 
Start menu, Shut Down command.

4 Turn the rotary isolator switch to OFF. 
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The AccuFlex Main Window
The AccuFlex Main Window

Introduction When you log on, the AccuFlex Main Window appears. This section explains the 
controls and features of this window.

In this Section Refer to the following:

UP5451

Topic See Page

Title Bar 13

Machine Status / Message Bar 13

Conveyor Control and Status Indicator 13

Menu Bar 14

Toolbar 15

Process Operation Buttons 18
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Title Bar
Title Bar

Description The title bar shows the name of the program being run, the current PCB file, and its 
location on the computer hard drive or network.

Machine Status / Message Bar

Description At the lower left of the main window, the Machine Status/Message Bar shows:

• Machine Status, what the machine is doing, or, 
• System prompts, the commands which will be carried out if you the click at the 

present pointer position.

Conveyor Control and Status Indicator

Description The conveyor control and status indicator uses a three block icon to represent the 
three-stage conveyor.

The single track conveyor is represented by a single square.

You can manually transfer boards left or right by clicking the direction arrows at either 
end of the status indicator.

If the indicators are red, you will be prompted to initialize the conveyor.

Press OK to initialize the conveyor.

UP5006
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Menu Bar
Menu Bar

Description The menu bar has ten drop-down menus. In many cases, commands in these menus 
are duplicated on the toolbar. The following explains the contents of the menus.

Menu Description

File Standard Windows operation such as New, Open, Save, Save 
as..., Print Setup, Exit.

User The User menu allows you to log on and off the AccuFlex. 

Setup This menu contains parameters such as Product information, 
Print profile, Tooling, Vision, Squeegees, Configure machine, 
Stencil clean, Paste dispenser profile, 2D inspection, and the 
notebook file for a product. 

Production Use this menu to print boards. It contains Run, and Bypass print. 

Utilities This menu contains Printer utilities, Initialize machine, Clean 
stencil, Inspect paste, Dispense paste, Swap print position, SPC 
utilities, SPC reports, and SPC chart replay. 

Diagnostics This menu contains access to the diagnostic routines: Print 
head, Stencil cleaner, Stencil load , Board transfer, XYY table, XY 
camera, Paste dispenser, Powered rail, Interlocks, Tooling Input, 
and Rheometric pump. 

Configure This menu is used to define the configurations and calibrations 
of the Print table, Camera, Camera light meter, Product transfer, 
Beacon, Options, SPC, and Counters. 

Service This menu contains Crate diagnostics, Edit SigPro.ini file, Vision 
self test, Test sequence, Accuracy test, Burn in test, Camera 
stability test, Offsets calibration, and Jog. 

Debug This menu contains Simulation forms: Show all..., Secs 1comm 
diagnostics, and Log files: General Error, Secs, SPC, Versions 
and Messages.

Help The Help menu provides access to the AccuFlex version and 
copyright information and the on-line Help system. 
2-14 AccuFlex™ Programming and Operations Guide



. .
 . 

. .P R I N T E R  O V E R V I E W

Toolbar
Toolbar

Introduction You may find the toolbar easier to use than the pull-down menus. The icons represent 
general machine function and programming operations.

Right click the toolbar to set it to a two-row configuration. The bottom row is 
dedicated to programming, product file setup, and teaching functions. Work from left 
to right in the second row to program the machine.

If you right click the toolbar again, it returns to a single row configuration.

In this section Refer to the following:

Topic See Page

General Machine Function Icons 16

Programming Icons 17
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General Machine Function Icons

Descriptions There are eleven icons used to initiate/control general machine functions:

Toolbar Icon Description

Open Displays the Open file dialog. 
Equivalent to the Open command on the File 
menu.

Save Saves the current PCB file to disk.
Equivalent to the Save command on the File menu.

Initialize the Machine Returns the machine mechanicals to their datum 
positions. 
Equivalent to the Initialize command on the Utilities 
menu. 

Printer Utilities Displays the Utilities dialog. 
Equivalent to the Printer utilities command on the 
Utilities menu. 

Clean the Stencil Initiates the stencil cleaning cycle. 
Equivalent to the Clean stencil command on the 
Utilities menu. 

Inspect Paste on the Stencil Moves the squeegees away from the bead of 
paste on the stencil to allow inspection. Equivalent 
to the Inspect paste command on the Utilities 
menu. 

Dispense Paste on the Stencil Initiates the paste dispensing cycle.
Equivalent to the Dispense paste command on the 
Utilities menu. 

Swap Print Direction Moves the squeegees to the opposite print start 
position and changes the direction of the next print 
to be performed. 
Equivalent to the Swap print direction command on 
the Utilities menu. 

SPC Utilities Displays the SPC utilities dialog.
Equivalent to the SPC utilities command on the 
Utilities menu. 

SPC Reports Displays the SPC reports dialog.
Equivalent to the SPC reports command on the 
Utilities menu. 

SPC Chart Replay Displays the SPC chart replay dialog.
Equivalent to the SPC chart replay command on 
the Utilities menu. 
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Programming Icons
Programming Icons

Descriptions There are ten icons used to initiate/control programming functions

Toolbar Icon Description

Edit PCB Info Displays the Product information dialog.
Equivalent to the Product information command on 
the Setup menu. 

Edit Print Profile Displays the Print profile dialog. 
Equivalent to the Print profile command on the 
Setup menu. 

Edit Tooling Profile Displays the Tooling dialog.
Equivalent to the Tooling command on the Setup 
menu. 

Edit Vision Profile Displays the Setup vision dialog.
Equivalent to the Vision command on the Setup 
menu. 

Calibrate Squeegees Displays the Squeegees zero pressure calibration 
dialog for the optional closed loop pressure 
system. 
Equivalent to the Squeegees command on the 
Setup menu. 

Edit Stencil Clean Profile Displays the Stencil cleaner parameters dialog.
Equivalent to the Stencil clean profile command on 
the Setup menu. 

Edit Paste Dispense Profile Displays the Paste dispense dialog.
Equivalent to the Paste dispense profile command 
on the Setup menu. 

PCB Vision Inspection Displays the PCB 2D Inspection dialog.
Equivalent to the 2D Inspection/PCB command on 
the Setup menu. 

Edit Setup Notes Displays the Windows 2000 Notebook dialog.
Equivalent to the Notebook command on the 
Setup menu. 

Help Contents Brings up the On-Line Help system contents page. 
Equivalent to the Contents command on the Help 
menu. 
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Process Operation Buttons

Descriptions The Start, Pause and Abort buttons allow you to control a process program from the 
Machine screen. The buttons are on the right side of the screen, and are identified as 
follows:

 Icon Description

Start Appears green when the machine is idle and ready to run a 
process program. When the machine is running a program the 
button will be light green.

Pause Appears yellow when the machine is running a process program. 
When the machine is idle (not running a process program) the 
button will be light blue.

Stop Appears red when the machine is running a process program. 
When the machine is idle (not running a program), the button will 
be light red.
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User Access
User Access

Introduction The AccuFlex requires that users identify themselves by name and password. When 
you do this for the first time, you create a user account. 

System user accounts are part of the machine configuration, they are not part of a 
particular board configuration.

Permission Levels A fully privileged user account is provided with each new machine. It allows you to 
setup the machine, and create other user accounts with varying permission levels. 

Each user is assigned a permission level from 1 to 10. 

In addition, each user may have varying permission levels for each menu. The user 
must have a permission level equal to or greater than that of the menu to access the 
contents of that menu.

For example, if the Production menu is set to 1, the File menu to 3 and the 
Configuration to 5, a user with a permission level of 4 will be able to access the 
contents of Production and File menus, but not the Configuration menu.
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User Access
Creating a New 
User Account

To create a new account:

Step Action

1 Select Users form the Configure menu to view the Users dialog.

2 Click Next user, or Previous user to view the details of existing user 
accounts. You may delete a user from this list by clicking the Delete 
user button.

3 Click New user to clear the user name and password fields.

4 Enter first and last names and a password. Retype the password for 
confirmation. If the passwords do not match, you will be prompted to 
retype them. 

5 In addition to the user name and password, a default log on name, such 
as ADMIN, appears with a preset permission level. The default log on 
names and their access levels are shown in the table below.

6 To change the user’s permission level:
Select a level from 1 (lowest ) to 10 by using the scroll bar to the right of 
the permission level field. 

7 Click Close to exit the dialog.

UP5047
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User Access
Default Log On 
Names and 
Permission Levels

The default log on names and permission levels are:

Setting Menu 
Permission Levels

To set a user’s permission levels for individual menus:

Default Menu 
Permission Levels

To prevent unauthorized changes, set high permission levels for users. The following 
permission levels are recommended:

Default Log on Name Permission level

Operator 3

Setup 4

Supervisor 5

Administrator 10

Step Action

1 Select System Access from the Configuration menu. The System 

access permission levels dialog appears.

2 Click the button next to a menu and use the scroll bar to adjust upwards 
or downwards. Refer to Default Menu Permission Levels for a list of 
recommended settings.

3 Repeat for each menu that you wish to change.

4 To save the changes, click Close.

UP5048

Menu Permission level

Production 1

Utilities 2

File 3

Setup 4

Configuration 5

Diagnostics 6
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Working With Product Files
Working With Product Files

Introduction The product file contains the specific details used to print a board.

Opening a Product 
file

To open a product file:

Creating a Default 
Product File

To create a product file that is based on the AccuFlex default settings:

Step Action

1 Click the Open icon on the toolbar, or choose Open from the File menu. 
The Open dialog appears.

2 Scroll through the list of file names at the left and select the desired file.

3 Click OK. 
If a file is already loaded, you will be prompted to save any changes 
before it is replaced with the selected file. 
Choose Yes or No.
The new file name appears in the title bar. 

UP5062

Step Action

1 Select New from the File menu. 

2 In the file name field, type a name that can be easily associated with the 
product so that it can be easily retrieved in the future.
For example: A demonstration product file could be called DEMOPCB1.
If you enter a name that has already been taken, you will be prompted 
to choose another or overwrite the existing name.
The suffix .SMT is automatically added to the filename. 

3 Click OK. The name appears on the status line at the bottom of the 
screen. 
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Working With Product Files
Creating a Product 
File Based on an 
Existing File

To create a product file that is based on an existing file:

Abandoning 
Changes

You can abandon any changes you have made since the last save, and use the 
previously saved version of the file to continue. Do this as follows:

File Naming 
Conventions 

Files are stored on the hard disc of the computer. They may also be stored on a 
network. AccuFlex files may have any valid Windows file name, according to the 
following rules:

• File names may have from one to thirty two characters.
• The .SMT file name extension is added by the system and should not be added 

by the operator. 
• Use any characters (including spaces) except: *?,;[]+=\/:|<>.
• The period may only be used to separate the file name from the extension.
• Upper and lower case characters may be used interchangeably.

Step Action

1 Open the desired file and save it. 

2 Select Save as... from the File menu.

3 In the file name field, type a name that can be easily associated with the 
product.

4 Click OK. The name appears on the status line at the bottom of the 
screen.

Step Action

1 Select Open from the File menu. 

2 Click the name of the file you are currently working on. 

3 Click OK. You will be prompted to save changes to the existing file.

4 Click No. 
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Defining the Beacon Signals
Defining the Beacon Signals

Introduction The AccuFlex is fitted with a three-lamp beacon. The meaning of the beacon signals 
can be configured to suit your needs.

Configuring the 
Beacon

To configure the Beacon:

Step Action

1 Select Beacon from the Configure menu. This displays the Beacon 
Configuration dialog.

2 For each function listed, check in the first column, under the orange 
color, if the alarm is to be audible. A check mark in the box indicates that 
the condition will cause the alarm to sound. Clicking the box again 
changes its state.

3 For each function, choose one of the three colors, red, blue, or green, 
by clicking the button beneath that color. You can only check one color 
for each function.

4 For each function, check the box under Flash, if a flashing beacon is 
desired. Clicking the box again changes its state.

5 Repeat for each item in the list.

6 When finished click OK. 

UP5057
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Colors

Audible
Alarm
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Defining the Beacon Signals
European Union 
Required Colors

The following shows the color and function regulations which must be followed if the 
printer is to be used in the European Union. The colors indicated refer to those in the 
Beacon configuration dialog.

Color Function

Green The machine is in a normal, safe state.

Red The machine is in an abnormal, or unsafe state.

Blue (or White) Other states (e.g., intervention required)

Orange Audible Alarm
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Initializing
Initializing

Introduction Initializing is the process which returns the mechanical assemblies of the machine to 
the default settings.

It is often necessary to initialize the machine before carrying out many processes.

Initialization 
Procedure

To initialize the machine:

Step Action

1 Select Initialize machine from the Utilities menu or click the Initialize 
Machine icon.

2 The Machine initialization dialog appears. 
The AccuFlex gives you a choice of items to initialize, with the items it 
considers necessary already checked.
Check additional items as needed.

ATTENTION

The Rails check box will not be displayed with manual 
rail setup.

3 To select all the items, click Set all.

4 To initialize the selected items, click OK.
A number of messages appear as initialization takes place.
When the dialogs cease, the machine is initialized.
You can then proceed with other operations. 

UP5042
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Fitting Squeegees
Fitting Squeegees

Introduction In addition to fitting a new set of squeegees, you must set the point at which the 
squeegees contact the stencil.

Figure Refer to the following figure when fitting squeegees:

UP5058
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Fitting Squeegees
Procedure To fit a set of squeegees:

Step Action

ATTENTION

Damage to the stencil or squeegees may occur if the squeegees are 
mounted or angled incorrectly.

Squeegee condition is important in obtaining a good print quality. 
Both squeegees must be clean and free from marks on the trailing 
edge that could result in uneven paste distribution.

1 Raise the front cover.

2 Place the screwed rods of the rear squeegee in the vertical slots, 
ensuring that the blade is angled away from you at the bottom.

3 Tighten the two thumbscrews.

4 Place the screwed rods of the front squeegee in the vertical slots, 
ensuring that the blade is angled toward you at the bottom

5 Tighten the two thumbscrews. 

6 Confirm the squeegees are seated correctly.

7 Close the front cover. 
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Configuration Options
Configuration Options

Introduction Options, under the Configure menu, is split into two tabs:

• Product changeover tab 
• Product file tab 

In this section Refer to the following:
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Topic See Page

Product Changeover Tab 30

Product File Tab 31
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Product Changeover Tab
Product Changeover Tab

Introduction The Product changeover tab allows you to determine what actions take place 
automatically when the printer is first powered on and when the product file is loaded 
or changed. 

You can determine:

• if the stencil is changed
• if the tooling is changed
• if the conveyor width is changed
• if a paste dispense cycle is performed
• if changeover operations must be acknowledged by the operator

Using the Product 
Changeover Tab

To use the Product changeover tab:

Step Action

1 Select the Product changeover tab.

2 To set any of the four actions, check the corresponding box.

3 To unset the actions, clear the box by checking it again.

4 To prompt the operator to confirm each individual action prior to 
initiation, check the Confirm actions box.

5 To exit the dialog and confirm the changes you have made, click OK.

6 To exit the dialog and cancel changes you have made, click Cancel.

UP5032
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Product File Tab
Product File Tab

Introduction The Product file tab allows you to:

• select a default disk drive and directory for product files
• use the PCB file that was current at the end of the previous session as the 

default for the next session
• show product notes of a PCB file after a changeover

Using the Product 
File Tab

To use the Product file tab:

Step Action

1 Select the Product file tab.

2 To define on which disk PCB files are stored by default, click the down-
arrow at the right of the Drive box to display the available drives. 

3 Click the drive letter to select a drive.

4 To select a default directory, note the path of the current default 
directory. To display the other directories which may be under a 
directory, double-click that directory. 
Alternatively, click in the Default file storage location box and type the 
path name.

5 If the Open last file on start box is checked, the product file which was 
most recently loaded is automatically reloaded when the system starts.
If this box is not checked, the system starts with the Default product 
file loaded.

6 If the Show notes on file open box is checked, a system prompt asks if 
you want to display the product file notes.

If this box is not checked, the system does not prompt you to choose to 
display the product file notes. 
The product file notes are still available on the Production Status screen 
under the Notes tab and from Notebook on the Setup menu.

UP5033
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Utilities
Utilities

Introduction This section contains descriptions of four basic utility menu functions.

To access the utilities dialogs, select Printer utilities from the Utilities menu, or click 
the Printer Utilities icon.

The options available under the Utilities menu item are split into four tabs:

• Printhead tab which provides controls to move the printhead.
• Paste tab which allows you to inspect the paste on the stencil, dispense paste, or 

position the paste dispenser to facilitate the changing of the paste cartridge.
• Stencil tab which provides for cleaning, loading, unloading and releasing the sten-

cil, or for positioning the stencil cleaner in order to fit a new roll of cleaning paper.
• Tooling tab which can be used to manually control the rotational position of the 

tooling pin carousel enabling you to reload the tooling pins.

In this section Refer to the following:
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Topic See Page

Printhead Utilities 33

Paste Utilities 34

Stencil Utilities 37

Tooling Utilities 39
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Printhead Utilities
Printhead Utilities

Using the Printhead 
Tab

To use the Printhead tab:

Step Action

1 Select the Printhead tab.

2 Be sure the machine is initialized and click Move to front or Move to 
rear. These functions are useful for checking limits and putting solder 
paste on the stencil. If the printhead is already in the chosen position, 
no action results.

3 To move the print carriage to the front or rear limit, click Move to front 
or Move to rear. 
These functions are useful for checking limits and putting solder paste 
on the stencil.

4  If the printhead is already in the chosen position, no action results.

UP5035

Click to Move the Print
Carriage to the Front

Click to Move the Print
Carriage to the Rear
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Paste Utilities
Paste Utilities

Introduction Refer to the following safety information when using the paste dialog:

Chemical Hazard

Solder paste and other printing medium contain lead and are hazardous to your 
health and the environment. Review Material Safety Data Sheet before use. 
Always wear protective gloves and safety goggles when handling printing 
medium and make sure you properly dispose of all waste material according to 
manufacturer’s instructions. Failure to comply could result in personal injury 
and/or damage to the environment.

Flammable

Use of non-approved solvents poses a serious risk of fire. Although a variety of 
solvents are available on the market for use with stencil cleaning systems, 
Speedline/MPM authorizes only those which it has tested and approved for use.

It is imperative that only Speedline/MPM-approved materials be used, as certain 
others may have too low a flash point (below 100°F), are not compatible with 
parts used in our system, or have too strong an odor.

The approved list of solvents is continuously updated as existing materials are 
re-evaluated and new materials are tested and approved. Please contact your 
Speedline Service representative for an updated list of approved solvents prior 
to adding any solvent to the Speedline/MPM stencil cleaning systems. 

Speedline/MPM will not be responsible for any damage and/or injury occurring 
as a result of using non-approved solvents
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Paste Utilities
Using the Paste Tab To use the Paste tab:

Step Action

1 Click on the Paste tab. The use of the buttons in this tab is explained 
below. 

For example, to change the paste cartridge, click Change cartridge and 
continue with step 2. 

2 Lift the front cover.

Click to Edit or View 
the Paste Dispenser 
Setup Parameters

UP5511Click to Stop the Paste Dispenser

Click to Dispense Paste

Set the Number of Paste
Dispensing Cycles

Click to Raise the Squeegees and
Inspect the Paste on the Stencil

Click to Position the Paste Dispenser
for a Paste Cartridge Change

Check This Box to Dispense Paste Over the Full PCB Width
AccuFlex™ Programming and Operations Guide 2-35



2
P R I N T E R  O V E R V I E W

Paste Utilities
3 Unscrew the top of the cartridge cover and lift out the empty paste 
cartridge.

4 Take off the nozzle. It is advisable to clean the nozzle at this point. 

5 Remove the caps from the new cartridge and attach the nozzle.

6 Put the new cartridge in the holder and screw the cover back on.

7 Click the close box to exit the dialog.

Step Action

UP5481
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Stencil Utilities
Stencil Utilities

Stencil Dialog Clicking Stencil displays the Stencil dialog:

Stencil Dialog 
Description

The following functions are available:

Operate the
Stencil Cleaner

UP5037

Prime the
Stencil Cleaner

Release/Clamp
the Stencil

Position the Stencil Cleaner
to Change the Cleaning

Paper Roll

Load/Unload
the Stencil

Edit or View the
Stencil Cleaner

Setup Parameters

Part Function

Clean Stencil Button Initiates a cleaning cycle.

Prime USC solvent Turns on the solvent pump for the duration of the prime 
cycle set in the Stencil Cleaner Setup, Advanced tab. The 
prime duration may be set from.1 second to 10 seconds.

Change USC paper Initiates a change paper routine (see Change Stencil Cleaner 
Paper)

Load stencil button Releases the stencil latches and moves the printhead to the 
front so a stencil may be loaded.

The Unload stencil 
button

Releases the stencil latches so that the stencil may be 
removed. Only available with Auto Stencil Positioning.

Release stencil 
button

Releases the stencil latches so that the stencil may be 
repositioned by hand.
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Changing Stencil Cleaner Paper
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Changing Stencil Cleaner Paper

Procedure To change the paper:

Step Action

Chemical Hazard

Used stencil cleaning paper contains solder paste and solvent 
residue. Consult solder paste and solvent Material Safety Data 
Sheets prior to handling used stencil cleaning paper. Properly 
dispose of all waste material according to manufacturer’s 
instructions. Failure to comply could result in personal injury and/or 
damage to the environment.

1 At the Printer utilities Stencil tab, click the Clean stencil button.

2 Click Change USC (Under-Stencil Cleaner) paper. 
The printhead moves to the rear, the stencil cleaner moves to the front, 
and the head latches release.

3 Lift the front cover.

4 Remove the stencil.

ATTENTION

Reusing stencil cleaner paper on the opposite side is not advised.

5 Fold the end of the paper to make it easier to feed into the mechanism.

6 Fasten the end of the paper to the take-up roll with a small piece of 
sticky tape.

7 Follow this path with the paper:

8 Close the printhead and click OK.

UP5039

Fold

Fold

UP3UG29

Paper Guide

Take-up
Roll

Supply Roll

Removable
Rod

Front of Printer

Solvent
Bar

FrontRear

Wiper/Plenum
Blade

Paper
Guides
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Tooling Utilities
Tooling Utilities

Using the Tooling 
Tab

To use the Tooling tab:

Step Action

1 Click on the Tooling tab.

2 Press Setup to view the auto-tooling parameters.

3 Press Store to place board supports in the carousel.

4 Press Position to place board supports on the table.

5 Press Load tooling pins to rotate the carousel so that pins may be 
placed in it manually.

Place Board Supports
on the Table

UP5398

Replace Board
Supports in the Carousel

Manually Rotate
Carousel

Edit or View the
Auto/Tooling

Setup Parameters
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Using the Help System
Using the Help System

Introduction The AccuFlex includes a Help system that is available with a single click.

Guidelines Follow these guidelines to use the Help system:

• To open the help system at the topic relevant to the dialog you are currently 
using, click Help within that dialog.

• To open the Help system at the contents page, click the Help system icon on the 
toolbar in the AccuFlex main window.

• You can find further information by clicking on underlined text.
• Use the menu buttons to navigate within the system.

• To leave the Help system, click the close box or choose Exit from the File menu. 
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